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Dedication

Respectfully dedicated to the memory of:

Francis R Scobee
Michael J Smith

Ellison S Onizuka
Judith A Resnick
Ronald E McNair
Gregory Jarvis

S Christa McAuliffe

the crew of Challenger flight STS 51-L, 28th January 1986
and to all who have lived - and died - for The Dream.

"Oh, I have slipped the surly bonds of earth,
And danced the skies on laughter-silvered wings;

Sunward I've climbed and joined the tumbling mirth
Of sun-split clouds -- and done a hundred things

You have not dreamed of -- wheeled and soared and swung
High in the sunlit silence. Hov'ring there,

I've chased the shouting wind along and flung
My eager craft through footless halls of air.

Up, up the long, delirious, burning blue
I've topped the wind-swept heights with easy grace,

Where never lark, or even eagle, flew;
And, while with silent, lifting mind I've trod
The high, untrespassed sanctity of space,

Put out my hand, and touched the face of God."

"High Flight"      John G Magee Jr, 1943
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About SkyMap
SkyMap is a "Planetarium" program for Microsoft Windows version 3.1 or later.    It will 
display a map of the sky as seen from any point on Earth for any date between 4000BC and
8000AD.    Two different types of map can be drawn - a "Horizon" map showing the 
observer's local horizon, and a "Sky Area" map showing a detailed view of a small area of 
the sky.    You can get information about any object displayed on the map by simply pointing
at the object with the mouse and clicking the button.    The display of additional 
information, such as constellation figures or star labels can be switched on and off with a 
click of the mouse button, making it easy to see exactly what you want without being 
overwhelmed by unwanted information.    When you have the map exactly as you want it, 
you can print it on any printer supported by Windows, in either black and white or colour.

SkyMap can also display photographic images, supplied in the form of GIF or Windows 
bitmap files.      Thousands of such images are freely available on bulletin boards and 
commercial information systems such as CompuServe and BIX.    This allows you to build up
your own personal library of astronomical photographs which, coupled with the map 
displays, really helps to bring the sky to life!

There are a number of planetarium programs available today.    Unlike some of these, 
SkyMap makes no claims of blinding calculation speeds.    Instead, what SkyMap 
concentrates on is accuracy.    When writing SkyMap I've used the most accurate methods 
available to me for all the calculations.    This accuracy makes SkyMap equally suited for 
both the novice astronomer who just wants to know "what's that bright object up there?" 
and the serious amateur or professional astronomer who wants a detailed "finder chart" for 
a faint galaxy.    Appendix A of this manual describes the data sources SkyMap uses, and 
gives an indication of the likely errors in its calculations.

SkyMap carries out its calculations in as efficient as manner as possible, but it never 
compromises accuracy for the sake of speed.    An increase in speed can always be 
achieved by using a faster computer!    Having said all that, the speed is still reasonable; on
the author's 33MHz 486-based PC for example, the horizon map, with default settings, is 
computed and drawn in about 5 seconds.

Although I am releasing SkyMap as Shareware, I quite appreciate that you may not consider
it worth paying any money for in its current form.    I would obviously like to be paid the 
registration fee - I've put a great deal of work into this software - but I would still appreciate
receiving your feedback on the program even if you feel it's not currently worth registering. 
If you do feel this way I'd like to know what, if anything, I could do to make you change 
your mind in the future!

Whilst developing SkyMap I've received the help and encouragement of a number of 
people.    I'd especially like to thank David Webber for many useful suggestions and help 
with the mathematical problems I encountered, and Steve Moshier for generously 
consenting to allow me to use many of his coding ideas for various astronomical 
calculations.    Finally, I'd like to thank Jean Meeus for writing the book "Astronomical 
Algorithms" (Willman-Bell, 1991), without which this program would never have existed.



What is Shareware?

Shareware distribution gives users a chance to try software before buying it. If you try a 
shareware program and continue using it, you are expected to register. Individual programs
differ on details -- some request registration while others require it, some specify a 
maximum trial period. With registration, you get anything from the simple right to continue 
using the software to an updated program with printed manual.

Copyright laws apply to both Shareware and commercial software, and the copyright holder
retains all rights, with a few specific exceptions as stated below. Shareware authors are 
accomplished programmers, just like commercial authors, and the programs are of 
comparable quality. (In both cases, there are good programs and bad ones!) The main 
difference is in the method of distribution. The author specifically grants the right to copy 
and distribute the software, either to all and sundry or to a specific group. For example, 
some authors require written permission before a commercial disk vendor may copy their 
Shareware.

Shareware is a distribution method, not a type of software. You should find software that 
suits your needs and pocketbook, whether it's commercial or Shareware. The Shareware 
system makes fitting your needs easier, because you can try before you buy. And because 
the overhead is low, prices are low also. Shareware has the ultimate money-back guarantee
-- if you don't use the product, you don't pay for it.



Disclaimer Agreement

Users of SkyMap must accept this disclaimer of warranty:

"SkyMap is supplied as is.    The author disclaims all warranties, expressed or implied, 
including, without limitation, the warranties of merchantability and of fitness for any 
purpose. The author assumes no liability for damages, direct or consequential, which may 
result from the use of SkyMap."

SkyMap is a "shareware program" and is provided at no charge to the user for evaluation.    
Feel free to share it with your friends, but please do not give it away altered or as part of 
another system.    The essence of "user-supported" software is to provide personal 
computer users with quality software without high prices, and yet to provide incentive for 
programmers to continue to develop new products.    If you find this program useful and 
find that you are using SkyMap and continue to use SkyMap after a reasonable trial period, 
you must make a registration payment to Chris Marriott.    The registration fee will license 
one copy for use on any one computer at any one time.    You must treat this software just 
like a book.    An example is that this software may be used by any number of people and 
may be freely moved from one computer location to another, so long as there is no 
possibility of it being used at one location while it's being used at another. Just as a book 
cannot be read by two different persons at the same time.

Commercial users of SkyMap must register and pay for their copies of SkyMap within 30 
days of first use or their license is withdrawn.    Site-License arrangements may be made by
contacting Chris Marriott.

Anyone distributing SkyMap for any kind of remuneration must first contact Chris Marriott 
at the address below for authorisation. This authorisation will be automatically granted to 
distributors recognised by the ASP as adhering to its guidelines for shareware distributors, 
and such distributors may begin offering SkyMap immediately (However Chris Marriott must
still be advised so that the distributor can be kept up-to-date with the latest version of 
SkyMap.).

You are encouraged to pass a copy of SkyMap along to your friends for evaluation.    Please 
encourage them to register their copy if they find that they can use it.



ASP Ombudsman Statement

This program is produced by a member of the Association of Shareware Professionals (ASP).
ASP wants to make sure that the shareware principle works for you. If you are unable to 
resolve a shareware-related problem with an ASP member by contacting the member 
directly, ASP may be able to help. The ASP Ombudsman can help you resolve a dispute or 
problem with an ASP member, but does not provide technical support for members' 
products.    Please write to the ASP Ombudsman at 545 Grover Road, Muskegon, MI 49442 
or send a CompuServe message via CompuServe Mail to ASP Ombudsman 70007,3536.



Contacting the Author

If you have any questions about SkyMap, or you require support, you can contact me in a 
number of different ways:

1.    If you have the capability, e-mail is the best way to contact me.    It's quick, and a 
written request is always easiest to deal with.    I can be reached at any of the following 
addresses, in no particular order of preference:

Internet: chris@chrism.demon.co.uk
CompuServe: 100113,1140

2.    If you prefer to write me a letter, my postal address is:

Chris Marriott
9, Severn Road
Culcheth
Cheshire WA3 5ED
United Kingdom

I have no intention of moving, so that address should apply for the foreseeable future!    
Note that this is also the address to which registration fees should be sent.

3.    Finally, if you would like to speak to me in person, you can telephone me on the 
following number:

Within the UK:0925 76 4131
International: +44 925 76 4131

Please call at the weekend, or between 6pm and 10pm GMT during the week.    Please also 
remember that I am in the UK, and consider the time difference if you're calling from 
overseas.    I would not welcome a call at 3am if you happen to be on the west coast of the 
USA and you decide to phone me at 7pm local time!

Please feel free to contact me - I'd love to receive any comments you may have on the 
program, or suggestions as to how it could be improved.



Registering SkyMap
As described above, SkyMap is not free software.    It is shareware and, as such, you must 
register it if you find it useful after a reasonable trial period.    I would suggest that 30 days 
is reasonable for such a trial.    The shareware concept is based on trust, and I trust you to 
pay for this program if you are using it.    There are several different levels of registration 
available:
Personal:    Personal registration allows the program to be used by one person.    You may 
install the software on any number of computers, as long as only one will be in use at any 
one time.
Club:    Club registration allows free use by all members of an astronomy club (or, indeed, 
any other sort of club!), on any number of computers, whilst at club meetings.    Any club 
member who wants to use the program at home is still expected to register the program 
personally.
Educational:    Educational registration allows unrestricted copying and use of SkyMap 
within a school, college, university, or other educational establishment.
Corporate??:    Frankly, I can't imagine any corporate use for SkyMap, but if you are a 
corporate user and you'd like to negotiate a site license for use of SkyMap, please contact 
me to discuss it!
For full information about registration, including details of current prices and methods of 
payment, please refer to the separate registration form "REGISTER.TXT".
If you have access to CompuServe you may wish to take advantage of the on-line 
shareware registration forum to quickly and easily obtain a personal registration for 
SkyMap.    To do so, enter the command "GO SWREG" at any "!" prompt, and select program
ID 876.    The registration fee will be charged directly to your CompuServe account and, 
especially if you live in a country other than the UK, you will avoid the inconveniences 
caused by having to deal with foreign currency.
If you register SkyMap you will receive:
1.    A registered copy of the latest version of SkyMap, with the registration reminder 
removed from the "About SkyMap" box.
2.    A bound, illustrated manual.
3.    A much larger star database.
4.    Unlimited lifetime support, using any of the methods described in the "Contacting the 
Author" section of this manual.
5.    The right to purchase, for a small fee, additional materials which enhance the use of 
SkyMap.
6.    The right to upgrade to a registered copy of the latest version of SkyMap, at any time,    
for a nominal fee.    You may do this as often as you wish.
7.    A lifetime money-back guarantee.    If you ever find a serious bug in SkyMap which 
makes it unusable, your registration fee will be immediately refunded, with no questions 
asked.



System Requirements

SkyMap requires Microsoft Windows version 3.1 or above to run.    It will not work with 
Windows 3.0 or earlier.    Windows 3.0 had a number of major flaws, and early on in the 
development of SkyMap I made the decision not to support it.    I apologise if this 
inconveniences you, but supporting Windows 3.0 would have quite severely restricted 
certain aspects of SkyMap's operation.
You do not actually need a maths coprocessor to run SkyMap, but it will run very slowly 
without one.    SkyMap does a great deal a great deal of trigonometry while creating maps, 
and use of a coprocessor can speed up this process by a factor of ten or more!
SkyMap will work with any type of video card supported by Windows.    For best results, VGA
or better is recommended.    If you want to display photographic images you really need a 
card and monitor capable of displaying 256 (or more) colours at the same time, such as a 
"SuperVGA", "High Colour" or "True Colour" video card..
Maps can be printed, in either black and white or colour, on any type of printer supported 
by Windows.    The best results will be obtained from a laser or high-quality ink-jet printer, 
but perfectly acceptable results will be obtained from a 9-pin or 24-pin dot-matrix printer, 
too.
The files distributed with    SkyMap require a total of about 1.4MB of disk space.



Setting Up SkyMap

Before SkyMap can be used, it must be installed on your computer, then configured to 
know about your location and time zone.

Installing SkyMap on your Computer
Configuring SkyMap for your Location



Installing SkyMap on your Computer

SkyMap is distributed as three ZIP archive files - one containing the program and 
documentation; one containing the support files essential to the program's operation, and 
the third containing optional files which enhance the program but are not essential.

The program archive, which will probably be called "SKYMP13A.ZIP" should contain the 
following files:

README.1ST Read this file!
REGISTER.TXT SkyMap registration form
HISTORY.TXT SkyMap release history
SKYMAP.EXE The SkyMap program
SKYMAP.HLP On-line help file
SKYMAP.TXT This manual.
CTL3D.DLL 3D control library.
MWSPIN.DLL Spin button control library.
MSDNTB.DLL ToolBar library.

The data and support archive, which will probably be called "SKYMP13B.ZIP", should 
contain the following files:

README.2ND Read this file!
STAR.SKY Main star database.
STARNAME.SKY Star name database.
STARPROP.SKY Star proper name database.
CONFIGUR.SKY Constellation figures database.
CONNAME.SKY Constellation name database.
MOON.SKY Moon position database.
PLANETS.SKY Planet position database.

The optional files archive, which will probably be called "SKYMAP13C.ZIP", should contain 
the following files:

README.3RD Read this file!
CONOUTLN.SKY Constellation boundaries database
RNGC.SKY RNGC non-stellar object database
RNGCPOP.SKY RNGC object popular name database

You may also have one or more picture file archives.    Please refer to the "Displaying 
Pictures" section of the manual for information about how to use these.

To install SkyMap, carry out the following steps:

1.    Create a directory on your hard disk.    For the purposes of this discussion we'll assume 
you want to install the program in directory SKYMAP on your C: drive.    Enter the 
commands:



C:
MD \SKYMAP

2.    Unpack both the archive files into the directory.    Assuming that the archives are on a 
floppy disk in the A: drive you would do this with the commands:

CD \SKYMAP
PKUNZIP A:\SKYMP13A
PKUNZIP A:\SKYMP13B
PKUNZIP A:\SKYMP13C

3.    Read the "Readme" text files.    They may contain important additions to the information
in this manual!

4.    Select the Program Manager group you'd like to add the SkyMap icon into.

5.    From the Program Manager's "File" menu, select "New...".    A dialog box will appear.    
Select "Program Item" (this should be the default, anyway) and press the OK button.

6.    The "Program Item Properties" dialog will appear.    Fill it in as shown below, then press 
the <OK> button.

Description: SkyMap
Command Line: SKYMAP.EXE
Working Directory: C:\SKYMAP

The SkyMap icon (a picture of a telescope) should appear in the Program Manager group 
window.    SkyMap is now installed and ready to run.



Configuring SkyMap for your Location

When SkyMap is run for the first time, you must configure it for the your location.    Before 
SkyMap can correctly draw a map of the sky for you, you have to tell it where you are, and 
what time zone you are in.    To configure the program, carry out the following steps:

1.    Run SkyMap by double clicking on its icon in the Program Manager.    The empty SkyMap
main window should appear.    Note the grey "status bar" at the bottom of the window.    
This is used to display important information to the user, so keep an eye on it!

2.    From the File menu, choose "New...".    The "Create New Window" dialog box will appear,
which lists the different types of window you can create.    Press <Enter> to create a 
Horizon Map window, which will be the default.    A blank Horizon Map window will appear, 
and additional items will be added to the menu bar.    Note that the message "Press F5 to 
draw the map" has appeared on the status bar.    Ignore this message for the time being!

3.    From the "Options" menu, choose "Observer...".    The "Observer" dialog box will be 
displayed.    This is where you set up all the information about the location you will be 
observing from.

Fill in your longitude and latitude, each in degrees, minutes, and seconds.    You need not be
exact - a position correct to the nearest degree is fine unless extreme accuracy is required.

In the "Local Time" box enter your time zone, expressed in minutes ahead or behind 
Universal Time (UT), commonly called Greenwich Mean Time (GMT).    Eg, if your time zone 
is Eastern Standard Time, you are 5 hours behind UT, so you would enter "300" (5x60) into 
the text box, and click the button to change the display to read "minutes behind UT".

If Daylight Saving Time (called "Summer Time" in the UK) is currently in operation, check 
the appropriate box.    If it is not currently in force, leave the box blank.    If the box is 
checked, your local time is taken to be an extra hour ahead of UT.

4.    Finally, you should save the information you've entered.    From the "File" menu, choose 
"Save Defaults...".    A box will appear asking you if you really want to save the information. 
Press the "Yes" button, or just press <Enter> to save the information.    All the current map 
settings will be saved in a configuration file called SKYMAP.INI and will be used as the 
default values for all horizon maps subsequently drawn.

5.    Press the <F5> key.    A "Please wait" box will be displayed for a few seconds 
(depending on the speed of your computer), after which a map of the southern part of the 
sky as it currently looks from your location will appear in the map window.    Congratulations
- you have successfully drawn your first map!

Note the following features of the map:

1.    The "status bar" at the bottom of the window displays information about the map, such 



as the time and date, and the coordinates of the map centre.

2.    The "Toolbar" at the top of the window provides a shortcut method of accessing many 
of the most frequently used commands, as well as giving an instant view of which map 
features are currently enabled.

3.    Along the bottom of the map is the horizon, with the compass points displayed along it. 
By default, the program displays a view of    roughly one third of the sky, centred on the 
southern horizon.    The zenith (the point directly overhead) is at the top of the map.

4.    Stars are displayed as dots of differing sizes.    The brighter the star, the larger the dot.   
By default, stars down to magnitude 5.0 are displayed, although the star database supplied
with the program contains stars down to magnitude 7.0.    (The complete SAO catalog is 
reasonably complete down to about magnitude 9.5.)

5.    By default, constellation names and figures are displayed.    These can both be switched
off using the items on the "View" menu, or by clicking on the appropriate buttons on the 
Toolbar.

6.    Planets are shown as dots, with the standard astronomical symbol alongside.    The 
Moon is displayed with its correct phase and orientation.    The Sun is displayed as a hollow 
circle.



Horizon Maps

A horizon map shows the sky as seen from the observer's location for a particular time and 
date.    It will probably be the starting point for most runs of SkyMap.

Drawing a Horizon Map
Using a Horizon Map



Drawing a Horizon Map

To draw a horizon map, the following steps should be followed:

1.    From the "File" menu, choose "New...".    The "Create New Window" dialog box will be 
displayed, showing the different types of window that can be created.    "Horizon Map" 
should be the default selection in the list, so simply press <Enter> to create a new Horizon 
Map window.

2.    Use the items on the "Options" menu to set all the options required for the map.    
These options are described below.    Once the options have been set, you can save them to
be used as the defaults for all future Horizon maps by selecting the "Save Defaults..." 
option from the "File" menu.

3.    Use the items on the "View" menu to select which features you would like plotted on 
the map.    Most of these can also be selected from the Toolbar, too.

4.    Press the <F5> key to draw the map.    This process will take anything from a few 
seconds to (in extreme cases!) several minutes, depending on the speed of your computer, 
and the complexity of the map.

5.    When the map appears, you can zoom in or out on it, identify objects on it, or print it.    
These options are described later.

Viewpoint
Time
Observer
Stars
Star Labels
Labels
Constellation Names
RNGC Objects
Colours
Reduce Positions
Draw



Viewpoint
This option allows you to determine which part of the sky appear on the map.    When this 
option is selected, the "Horizon View" dialog is displayed.

The "Azimuth" and "Altitude" fields specify the coordinates of the centre of the map.    The 
azimuth corresponds to the compass direction you are looking in and has the value 0° for 
due North, 90° for East, 180° for South, and 270° for West.    The altitude indicates how far 
up you are looking, and is 0° on the horizon, and 90° directly overhead.

The "Radius" field specifies the vertical size of the map.    The minimum altitude displayed 
on the map will be "Radius" degrees below the centre; the maximum altitude will be 
"Radius" degrees above the centre (ie, the range of altitude displayed on the map will be 
double the value entered).    The azimuth range of the map is scaled automatically.

Notes:

1.    Even if the radius is greater than the centre azimuth (ie, Centre-Radius<0), objects 
below the horizon will not be displayed - the horizon line will simply appear higher up the 
map.

2.    To display a circular map of the whole sky, enter a centre altitude of 90°, and a radius of
90°.    In this case the azimuth setting simply determines the orientation of the map - the 
specified azimuth will be appear at the bottom of the map.



Time

The time and date for which the map is drawn are initially set from the computer's clock for
the instant that the Horizon Map window is created.    The Time option allows the user to 
display a map for any other time and date.    When this option is selected, the "Observation 
Time" dialog is displayed.

Fill in the dialog fields for the time and date required.    Pressing the "Now" button will read 
the time and date from the computer's clock.

Notes:

1.    Dates before 1AD should be entered as negative numbers in the normal astronomical 
manner.    Enter the year 1BC as "0", 1000BC as "-999", and so on.

2.    Dates must be between 4000BC (-3999) and 8000AD, this being the range over which 
the program's calculations are valid.

3.    Dates on or after 0h on 15th October 1582 are assumed to be in the Gregorian 
calendar; dates before then in the Julian calendar.

4.    The observation time is assumed to be a local time - ie, the time as shown on an 
observer's clock.    The time zone information specified on the Observation Location dialog 
(see below) is used to convert the time to UT.



Observer

The Observer option allows the user to enter information about the location from which the 
observation is taking place.    When this option is selected, the "Observer" dialog is 
displayed.

The "Latitude" and "Longitude" fields specify the location of the observer.    Both are 
entered in degrees, minutes, and seconds although, unless extreme accuracy is required, a 
position correct to the nearest degree will normally suffice.

The "Conditions" information describes the atmospheric temperature and pressure at the 
time of observation.    This information is used when calculating the effects of refraction.    
Changing these values only has a very small effect and, unless extreme accuracy is 
desired, they may safely be left at their default values.

The "Local Time" data specifies the observer's time zone.    It is used to convert the time of 
observation (which is always assumed to be local time) into UT or GMT.    The time 
difference is entered in minutes (not hours!) difference between local time and UT.    For 
example, an observer on the east coast of the USA, whose clocks are set 5 hours earlier 
than GMT, should enter "300" (5 x 60) in this box, and click the arrow to change the text to 
"before UT".

The "Daylight saving time" box should be checked if DST (called "Summer Time" in the UK, 
and perhaps other countries too) is currently in operation.    If the box is checked, the local 
time is assumed to be one additional hour ahead of UT.

Notes:

1.    The reason that the time difference is entered in minutes, rather than hours, is that not 
all countries are exact hours ahead of or behind GMT.    India, for example, is 5.5 hours (330
minutes) ahead of GMT.



Stars

The Stars option controls both which stars are plotted on the map, and the way that plotted
stars are displayed.    When this option is selected, the "Star Display" dialog is displayed.

The "Limiting magnitude of map" field determines the magnitude of the faintest star whose
position will be calculated.    The higher the number, the fainter the stars which will be 
displayed (and the longer the map will take to compute).    The star database supplied with 
the program contains stars down to magnitude 7.0; the full SAO star catalog has stars 
down to magnitude 9.5 or so.

The "Limiting magnitude displayed" field determines the magnitude of the faintest star that
will actually be displayed on the map.    Once a map has been drawn, you can change the 
value in this field to temporarily suppress the display of the fainter stars on a map, to 
remove "clutter".    The value entered in this field should be less than or equal to the value 
entered in the "Limiting magnitude" field above..

The lower half of the dialog box controls the way that the size of the star images varies 
with their magnitude.    All stars brighter than the first "Display mag" field will be displayed 
using the size of star circle shown to its right.    All stars fainter than the second "Display 
mag" field will be displayed using the size of star circle shown to its right.    All stars with 
magnitudes between these two limits will be drawn with an image size inversely 
proportional to the magnitude (ie, the brighter the star, the larger the image).

Notes:

1.    The number of stars rises very quickly with magnitude.    Generally, increasing the 
limiting magnitude by one magnitude will more than double the number of stars visible on 
the map, and consequently the time taken to compute their positions.



Star Labels

This option controls the way in which stars are labelled on the map.    When selected, the 
"Star Labels" dialog box is displayed.

The way in which stars are named has evolved over hundreds of years.    As a result, a lot of
the brighter stars have many different names.    The "Label Preferences" box allows the user
to determine which, if any, of those names is displayed on the map.

"Proper Names" refers to the "popular" name of a star, such as "Polaris" or "Rigel".
"Bayer Letters" refers to the convention of labelling the brightest stars in each constellation
with Greek letters, such as "Alpha Centauri" or "Beta Cygni".
"Flamsteed Numbers" refers to the convention of labelling stars in each constellation with 
numbers, such as "61 Cygni".

The "Label Options" box at the bottom of the dialog box determines which stars are 
labelled.    If "All stars" is selected, then all stars which have the appropriate name will be 
labelled.    If "Brighter than magnitude" is selected, then only those stars brighter than the 
number in the edit box will be labelled.

Notes:

1.    This dialog only determines the way in which stars are labelled.    If order to actually 
display star labels, the "Star Labels" option must be enabled on the "View" menu or the 
Toolbar.

2.    If a star has multiple names, and more than one of the naming options is selected in 
the "Preferences" box, the name highest up the box will be displayed.    Eg, if both the 
"Proper Names" and "Bayer Letters" options are selected, the map would display the name 
"Polaris" in preference to "Alpha Ursae Minoris" when labelling the pole star.



Constellation Font

This option allows the user to choose the font used for constellation names.    Selecting this 
option displays a standard font selection dialog.



Labels

Selecting this option displays a submenu of labelling options.    If the "Altitude" option is 
selected, the "Altitude Label Options" dialog box is displayed.
 
The "Label type" radio buttons allow the type of altitude labelling to be selected.    The 
options are:

Automatic The label interval is selected automatically.
Every ... The label interval is specified in the text box.
Nothing No altitude labels are displayed.

If the "Draw Altitude Lines" box is checked, altitude lines are drawn across the map at the 
appropriate (manual or automatic) intervals, and the lines are labelled at the left-hand side 
of the map.

If the box is blank, altitude tick marks are drawn in the centre of the map.

Notes:

1.    If the "Nothing" box is selected, neither altitude lines nor labels are drawn, regardless of
the state of the "Draw Altitude Lines" check box.

Selecting the "Azimuth" option from the "Labels" submenu displays the "Azimuth Label 
Options" dialog box.

The radio buttons in the "Label with" box control the type of azimuth labelling, and 
determine which (if any) of the other values in the dialog are used.

If the "Compass Points" button is selected, the horizon is labelled with the names of 
compass points, and the options in the "Compass Interval" section of the dialog are used.

If the "Azimuth" button is selected, the horizon is labelled with azimuth numbers (in 
degrees), and the options in the "Azimuth Interval" section of the dialog are used.

If the "Nothing" button is selected, the azimuth axis is not labelled, and the rest of the 
dialog is ignored.

The "Compass Interval" section of the dialog determines the labelling method used when 
"Compass Point" labelling is selected.    The radio buttons allow the labelling interval to 
either be determined automatically, or one of three manual intervals selected.
The "Azimuth Interval" section of the dialog determines the labelling method used when 



"Azimuth" labelling is selected.    The options allow the labelling interval to be either 
determined automatically, or specified manually by the value in the text field.

If the "Draw Azimuth Lines" box is checked, lines are drawn up from the labelled points on 
the horizon to the top of the map.



RNGC Objects
Selecting this option displays the "RNGC Options" dialog box, allowing you to determine 
which deep sky objects are displayed on the map.

The "Object Selection" box determines which catalogue will be searched to find objects to 
display; the entire RNGC catalogue or only Messier objects.

The "Object Types" box controls which objects will be displayed on the map, based on their 
type.    If the "All objects" box is checked, then the other boxes in the group are ignored, 
and all objects which match the other selection criteria will be displayed.    If the "All 
objects" box is not checked, individual types of object can be selected using the other 
boxes in this group.

The "Magnitude Limit" box allows you to control which objects are displayed, based on a 
magnitude selection.    If "All Objects" is selected, then all objects matching the other 
selection parameters will be displayed; if "Brighter than mag" is selected, then only those 
objects brighter than the specified magnitude will be displayed.

Finally, the "Label Objects" box, determines whether displayed objects will be labelled.    If 
the box is checked, objects will be labelled.    Messier objects will be labelled "M" followed 
by a number (eg "M32"); other objects will simply have their RNGC catalogue number 
displayed (eg "1985" refers to the planetary nebula "RNGC 1985" ).

Notes:

1.    This is a complex dialog box - the most complex in the program! - but it gives you the 
ability to exercise very fine control over the non-stellar objects which are displayed.    For 
example, you can make selections such as "only display globular clusters in the Messier 
catalogue brighter than magnitude 11".

2.    The program will only display those Messier objects that are in the RNGC.    Four objects 
in the Messier catalogue are not in the RNGC, so will not be drawn.    These are: M24 (a 
local brightening of the Milky Way), M25 (the open cluster IC 4725), M40 (the wide double 
star Winneke 4), and M45 (the Pleiades).

3.    The RNGC is based on the NGC, compiled towards the end of the 19th century.    As 
such, it contains many incorrect classifications, based on the information available at the 
time.    For example, the Crab Nebula in Taurus, M1, we now know to be a supernova 
remnant, but the RNGC classifies it as a planetary nebula.    The RNGC is, however, a 
catalogue of great historical significance, and no attempt has been made by the author to 
"correct" it.

4.    The symbols used to draw non-stellar objects on the map have been based on those 
used in the authoritative "Uranometria 2000" star atlas.



Colours

This option displays a sub-menu allowing the user to select the colours used for every item 
drawn on the map for either the screen or the printer.    When either "Screen" or "Printer" is 
selected, the "Horizon Map Colours" dialog box is displayed.

To view or edit the colour of any map component, either double click on the name in the 
listbox, or move the listbox highlight to the name and press the "Edit..." button.    Either 
way, a standard colour selector box will be displayed, letting you choose the colour for the 
item.

Notes:

1.    Pressing the "Cancel" button will restore all the colours to their previous settings, not 
only the colour just edited.

2.    The "Printer" colour settings only relate to the printing of colour maps.    Refer to the 
printing topic for further information.



Reduce Positions



Draw

Selecting this option will draw the map, using the current option settings.    You may press 
the <F5> function key as a "shortcut" for this option.



Using a Horizon Map

Once the horizon map has been created using the methods described in the previous 
section of the manual, it can be manipulated in various way.    This section describes the 
available options:

Setting the Visibility of Objects
Changing the Map Scale
Identifying Objects on the Map
Zooming to an Area Map
Printing the Map



Setting the Visibility of Objects

The first section of the "View" menu contains a list of item names, each of which has a tick 
alongside if that type of item is currently visible.    The items are:

Stars
Star Labels
Planets
Constellation Figures
Constellation Boundaries
Constellation Names
Alt/Az Grid
RNGC Objects

Each of these items has a corresponding button on the ToolBar.    To change an item from 
visible to invisible, or vice versa, either select the item from the menu, or press the button 
on the ToolBar.



Changing the Map Scale

The "Zoom In" and "Zoom Out" items on the "View" menu may be used to change the 
magnification of the map.    The <F2> and <F3> function keys are shortcuts for these 
operations, as are the first two buttons on the ToolBar.    When the map is first drawn, it is 
scaled so that the map exactly fills a maximised map window.    Every time "Zoom In" is 
selected, the size of the map increases by 50%, and the map is redrawn.    Every time 
"Zoom Out" is selected, the size is correspondingly reduced.

When the map is zoomed, the centre of the current window will remain stationary.    You can
therefore zoom in a particular feature by first scrolling it to the centre of the window, then 
repeatedly pressing the <F2> key.    To aid this process, a shortcut method has been 
provided to bring a point to the centre:

1.    Position the mouse pointer over the point on the map you would like to bring to the 
centre.
2.    Press the right mouse button.    A pop-up menu will appear under the mouse pointer.
3.    Select the "Centre" item with the left mouse button.    The window will scroll to bring the
chosen point to the centre of the map.

Note that the map will not scroll past its edges (the boundaries of the full-screen normal 
size map).    In order to bring a point to the centre of the map it may, therefore, be 
necessary to zoom in one or more times first.



Identifying Objects on the Map

To display a dialog box showing information about any object visible on the map, move the 
mouse pointer over the object, and press the right mouse button.    A pop-up menu will 
appear.    Select the item you wish to identify.

Star Identification
Planet Identification
RNGC Object Identification



Star Identification

If you ask for information about a star, a "Star Information" dialog box is displayed.    The 
amount of information displayed will depend on the star, but will include the following:

1.    The star's SAO catalogue number is displayed in the dialog box title.    The SAO number 
is the way that SkyMap identifies the star internally - all other information is derived from 
this.

2.    The top section of the dialog displays the identify of the star.    The same star can be 
identified in a truly bewildering variety of different ways.    SkyMap attempts to show a few 
of the more popular names for the star:

The first line of the dialog always displays the name of the constellation that the star is in.   
In the case of a star which has either a Bayer letter or Flamsteed number, the star's 
constellation is actually stored in the database.    In cases where this information is not 
present, the constellation is computed from the star's position, using the official IAU 
constellation boundaries.

The next line, if present, displays the "proper name" of the star - "Rigel", for example.    
Note that many star names are derived from Arabic and, as such, have a number of 
alternate English spellings.    In the case of such stars, the name that SkyMap displays may 
well be slightly different from the name your reference sources show.    All that means is 
that I used a different reference book!

Next are shown the star's Bayer letter (eg beta Orionis) and Flamsteed number (19 
Orionis), if present.

Finally in the initial section of the dialog, the star's visual magnitude is shown.

3.    The lower section of the dialog shows the position of the star in several different 
coordinate systems.

First, the star's apparent geocentric right ascension and declination are displayed.    These 
coordinates are referred to the true equinox and ecliptic of date, and are corrected for:

Proper Motion
Annual Aberration
Precession
Nutation

The star's position is also corrected for refraction before being displayed on the map, but 
the apparent position displayed in the dialog box does not include this correction.



Next, the star's catalogue position is displayed - the right ascension (RA) and declination for
the mean equinox and ecliptic of epoch J2000.0.    This information is taken straight from 
the SAO star catalogue and contains no position corrections.

Finally, the current altitude and azimuth as seen from the observer's location are displayed. 
The altitude displayed here includes the effects of refraction.



Planet Identification

If information about a planet is requested, a dialog with multiple screens of information is 
displayed.    The dialog has buttons down the right hand side for switching between the 
different screens of information.    The names on the buttons refer to the position of the 
viewer - eg, the "Sun" button displays a screen of heliocentric information.

The information displayed is as follows:

The "Local" screen displays information about the planet as seen from the observer's 
location at the time and date for which the map is displayed.    The following information is 
displayed:

1.    The altitude and azimuth of the planet as seen from the observer's location at the 
current time.    This is derived from the apparent geocentric position, with additional 
corrections being applied for diurnal parallax (the difference between the position of the 
planet as seen from the centre of the Earth and the position as seen from the observer's 
actual position) and refraction.

The "Earth" screen (initially displayed) displays information about the planet as seen from 
the centre of the earth - ie, geocentric information.    The following information is displayed:

1.    The apparent geocentric right ascension and declination, referred to the true equinox 
and ecliptic of date.    This position is corrected for the effects of:

Light Time
Light Deflection (due to the Sun's gravity)
Annual Aberration
Nutation

The position of the planet as displayed on the map has additional corrections for diurnal 
parallax and refraction, but these corrections are not reflected in the position displayed 
here.

2.    The constellation the planet is in.

3.    The true (geometric) distance of the planet in both astronomical units (exactly) and 
millions of km (approximately).    In the case of the Moon, the exact distance is displayed in 
km.

The "Sun" screen displays information about the planet as seen from the centre of the Sun -
ie, heliocentric data.    The following information is displayed:



1.    The apparent ecliptic longitude and latitude of the planet, referred to the true ecliptic of
date.

2.    The geometric radius vector of the planet (ie, the distance between the planet and the 
Sun) in both astronomical units (exactly) and millions of km (approximately).

The "Physical" screen displays physical information about the planet.    The following 
information is displayed:

1.    The visual magnitude.

2.    The phase, as a fraction between 0 and 1.    A phase of 0 indicates that the object is 
"new"; a phase of 1 is "full".    The phase is equal to the fraction of the planet's disk that is 
illuminated, as seen from the Earth.

3.    The apparent diameter, in seconds of arc.    For some planets, separate equatorial and 
polar diameters are shown.

4.    The phase angle, in degrees.    This is the angle between the Earth and Sun, as seen 
from the centre of the planet, and determines the phase of the planet as seen from the 
Earth.

5.    The elongation, in degrees.    This is the angle between the planet and the Sun, as seen 
from the centre of the Earth.

6.    The light time in hours, minutes, and seconds.    This is the time taken for light to travel 
from the planet to the observer, and is an indication of the "age" of the view we see of the 
planet.    Eg, if the light travel time for Mars is shown as 5 minutes, this means that we are 
seeing Mars as it actually was 5 minutes ago.



RNGC Object Identification

If you ask for information about an RNGC object, a dialog box is displayed.    The amount of 
information displayed will depend on the object, but will include the following:

1.    The dialog box title will contain the catalogue number of the object.    This will be shown
as a Messier number for objects in the Messier catalogue, and an RNGC catalogue number 
otherwise.

2.    The upper section of the dialog identifies and describes the object.    The following 
information could be displayed:

RNGC Number:    For Messier objects, the corresponding number in the RNGC catalogue.    
For example, in the case of "M44", this line will display "NGC 2632".

Popular name:    Some objects have a "popular name" by which they are commonly known, 
in addition to their various catalogue numbers.    For example, in the case of M44, this line 
will display the name "Praesepe".

Type of object:    A brief description of the object type, such as "Galaxy", "Globular Cluster", 
"Diffuse Nebula", etc.    As has already been stated, these classifications are not always 
correct, and should not be taken as an authoritative guide to what an object really is!    That
having been said, the classification is correct for the vast majority of objects.

Magnitude:    The visual magnitude of the object.    It should be noted that this is normally 
an "integrated magnitude" - the total amount of light received from the whole of the object.
Normally, a 10th magnitude galaxy is visually a lot fainter than a 10th magnitude star, 
because in the case of the galaxy the light is coming from an area of sky, rather than from 
a point source.

Description:    The "Dreyer Description" of the object.    When Dreyer compiled the NGC in 
1888, he gave a brief visual description of the object in a highly compressed format.    
These descriptions are, in the author's opinion, the real value of the NGC, since they 
indicate what you are likely to actually see in a typical modern amateur telescope.    The 
"encoded" format of the descriptions may seem cryptic and hard to understand at first but, 
with practice, soon becomes a useful source of information.    Refer to Appendix B of the 
manual for a description of Dreyer descriptions.

3.    The lower section of the dialog shows the position of the object in several different 
coordinate systems.

The first line displays the name of the constellation the object is in.

The second line shows the object's apparent geocentric right ascension and declination, 
referred to the true equinox and ecliptic of date.    The position is corrected for:



Annual Aberration
Precession
Nutation

The object's position is also corrected for refraction before being displayed on the map, but 
the apparent position displayed in the dialog box does not include this correction.    Note 
that rigorous position corrections are applied,    regardless of the current setting of the 
"Reduce Positions" switch on the "Options" menu.

Next, the object's catalogue position is displayed - the right ascension (RA) and declination 
for the mean equinox and ecliptic of epoch J2000.0.    This information is taken straight from
the RNGC catalogue and contains no position corrections.

Finally, the current altitude and azimuth as seen from the observer's location are displayed. 
The altitude displayed here includes the effects of refraction.



Zooming to an Area Map

If you wish to display a detailed "Area Map" of a particular region of the sky, position the 
mouse pointer over the point on the horizon map that you wish to be the centre of the area
map.    Press the right mouse button and select "Area Map..." from the pop-up menu.    The 
"Sky Area View" dialog box will appear, with the coordinates of the map centre already 
filled in.    Enter the radius of the map you would like, in degrees, then press <Enter>.    A 
blank area map window will appear.    The next chapter of the manual describes how to 
draw and use the Sky Area map.



Printing the Map

To print the map, choose the "Print" option from the "File" menu.    This will display the 
"Print Options" dialog box.

The "View Options" box selects what type of map is drawn.    If "Whole Map" is selected, the
entire map will be drawn, scaled to fit onto the printer page.    If "Current View" is selected, 
the current map view will be printed, at the current zoom factor.

The "Colour Options" box is used to select whether the map is printed in black and white or 
colour.    If "black and white" is selected, all objects on the map are printed black, and the 
map background is left white.    If "Colour" is selected, the map background is again left 
white, but the colour of all other objects is taken from the settings in the 
"Options/Colour/Printer" dialog.    

When the <OK> button is pressed, a standard "Print" dialog is displayed.    This allows you 
to select the printer, resolution, paper orientation etc in the normal way.    Press <OK> from
this dialog to print the map.

Notes:

1.    By default, the map is printed in landscape orientation.    If you wish to change this, use 
the "Print Setup" option.

2.    The default "Print Options" settings of "Whole Map" and "Black and White" correspond 
to the way that maps were printed in previous versions of SkyMap.

3.    The "Current View" printout is intended as a "quick and dirty" method of getting a 
printed map of a zoomed-in area of the sky, without having to draw a separate Sky Area 
map and print that.    No attempt is made to properly scale the map to fit the paper size, 
draw borders, or anything else.    If you have a very high zoom factor set, and try to print to 
a high-resolution device using this settings, problems may occur.

4.    The "Colour" setting in the "Colour Options" box can be used to print a grey-scale map 
even on a black and white printer.    The exact correspondence between colours and shades
of grey will depend on the capabilities of the printer driver.    This works beautifully on a 
PostScript laser printer; not so well on an Epson 9-pin dot matrix printer!



Sky Area Maps

A Sky Area map shows a detailed view of a (normally) small area of the sky, centred on a 
particular point of right ascension and declination.    It is a circular map, displaying all 
objects within a specified radius of the centre.

Drawing a Sky Area Map
Using a Sky Area Map



Drawing a Sky Area Map

There are two ways to draw a Sky Area map:

1.    Draw a horizon map, then click the right mouse button over the location you want to be
the centre of the Sky Area map.    Select "Area Map..." from the pop-up menu which 
appears.

2.    From the "File" menu, select "New...".    The "Create New Window" dialog box will 
appear.    Select "Sky Area Map" from the listbox and press <OK>.

Whichever of these two methods is used, the "Sky Area View" dialog box will be displayed.

The "Vertical Radius" field specifies the radius of the map, in degrees.    This must be 
between 1° and 90°.    The "Right Ascension" and "Declination" fields specify the 
coordinates of the map centre.    If you are drawing the Area map from a Horizon map, 
these will already contain the correct values.

When the dialog is correctly filled in, press <OK> to create a new map.    A blank Sky Area 
Map window will be displayed, and the menu will change to the Sky Area menu.

Use the items on the "Options" menu to set all the options required for the map.    These 
options are described below.    Once the options have been set, you can save them to be 
used as the defaults for all future Sky Area maps by selecting the "Save Defaults..." option 
from the "File" menu.

Finally, press the <F5> key to draw the map.    This process will take anything from a few 
seconds to (in extreme cases!) several minutes, depending on the speed of your computer, 
and the complexity of the map.

The items on the "Options" menu are:

Viewpoint
Time
Observer
Stars
Star Labels
Constellation Names
RNGC Objects
Colours
Draw



Viewpoint

This option allows the user to specify which part of the sky is visible on the map.    When 
this option is selected, the "Sky Area View" dialog is displayed.

The "Vertical Radius" field controls the radius of the map.    It can take values ranging from 
1º to 90º.    The total field of view of the map will be double the value entered here.

The "Right Ascension" and "Declination fields specify the coordinates of the centre of the 
map.    Right Ascension is entered in hours and minutes of time; declination in degrees and 
minutes of arc.



Time

The time and date for which the map is drawn are initially set from the computer's clock for
the instant that the Sky Area Map window is created.    The Time option allows the user to 
display a map for any other time and date.    When this option is selected, the "Observation 
Time" dialog is displayed.

Fill in the dialog fields for the time and date required.    Pressing the "Now" button will read 
the time and date from the computer's clock.

Notes:

1.    Although the map is drawn centred on a fixed point on the RA/Dec coordinate grid, the 
date and time are still used to calculate such things as planetary positions, and also, over 
long periods of time, affect which stars are visible on the map, due to the effects of proper 
motion and precession.

2.    Dates before 1AD should be entered as negative numbers in the normal astronomical 
manner.    Enter the year 1BC as "0", 1000BC as "-999", and so on.

3.    Dates must be between 4000BC (-3999) and 8000AD, this being the range over which 
the program's calculations are valid.

4.    Dates on or after 0h on 15th October 1582 are assumed to be in the Gregorian 
calendar; dates before then in the Julian calendar.

5.    The observation time is assumed to be a local time - ie, the time as shown on an 
observer's clock.    The time zone information specified on the Observation Location dialog 
(see below) is used to convert the time to UT.



Observer
The Observer option allows the user to enter information about the location from which the 
observation is taking place.    When this option is selected, the "Observer" dialog is 
displayed.

The "Latitude" and "Longitude" fields specify the location of the observer.    Both are 
entered in degrees, minutes, and seconds although, unless extreme accuracy is required, a 
position correct to the nearest degree will normally suffice.

The "Conditions" information describes the atmospheric temperature and pressure at the 
time of observation.    This information is used to calculate the effects of refraction, so has 
no influence on the Sky Area map.

The "Local Time" data specifies the observer's time zone.    It is used to convert the time of 
observation (which is always assumed to be local time) into UT or GMT.    The time 
difference is entered in minutes (not hours!) difference between local time and UT.    For 
example, an observer on the east coast of the USA, whose clocks are set 5 hours earlier 
than GMT, should enter "300" (5 x 60) in this box, and click the arrow to change the text to 
"before UT".

The "Daylight saving time" box should be checked if DST (called "Summer Time" in the UK, 
and perhaps other countries too) is currently in operation.    If the box is checked, the local 
time is assumed to be one additional hour ahead of UT.

Notes:

1.    The reason that the time difference is entered in minutes, rather than hours, is that not 
all countries are exact hours ahead of or behind GMT.    India, for example, is 5.5 hours (330
minutes) ahead of GMT.

2.    The location of the observer is used by the Sky Area map when calculating the effects 
of "diurnal parallax" for nearby objects such as the Sun, Moon, and planets.    This is the 
difference in the apparent position of a nearby body against the star background as seen 
from different places on Earth.    In the case of the Moon in particular, the correction for 
diurnal parallax is important, and can alter the Moon's apparent place by up to 2 degrees - 
4 times the Moon's apparent diameter! 



Stars

The Stars option controls which stars are plotted on the map, and also the way that plotted 
stars are displayed.    When this option is selected, the "Star Display" dialog is displayed.

The "Limiting magnitude of map" field determines the magnitude of the faintest star whose
position will be calculated.    The higher the number, the fainter the stars which will be 
displayed (and the longer the map will take to compute).    The star database supplied with 
the program contains stars down to magnitude 7.0; the full SAO star catalog has stars 
down to magnitude 9.5 or so.

The "Limiting magnitude displayed" field determines the magnitude of the faintest star that
will actually be displayed on the map.    Once a map has been drawn, you can change the 
value in this field to temporarily suppress the display of the fainter stars on a map, to 
remove "clutter".    The value entered in this field should be less than or equal to the value 
entered in the "Limiting magnitude" field above..

The lower half of the dialog box controls the way that the size of the star images varies 
with their magnitude.    All stars brighter than the first "Display mag" field will be displayed 
using the size of star circle shown to its right.    All stars fainter than the second "Display 
mag" field will be displayed using the size of star circle shown to its right.    All stars with 
magnitudes between these two limits will be drawn with an image size inversely 
proportional to the magnitude (ie, the brighter the star, the larger the image).

Notes:

1.    The number of stars rises very quickly with magnitude.    Generally, increasing the 
limiting magnitude by one magnitude will more than double the number of stars visible on 
the map, and consequently the time taken to compute their positions.



Stars Labels

This option controls the way in which stars are labelled on the map.    When selected, the 
"Star Labels" dialog box is displayed.

The way in which stars are named has evolved over hundreds of years.    As a result, a lot of
the brighter stars have many different names.    The "Label Preferences" box allows the user
to determine which, if any, of those names is displayed on the map.

"Proper Names" refers to the "popular" name of a star, such as "Polaris" or "Rigel".
"Bayer Letters" refers to the convention of labelling the brightest stars in each constellation
with Greek letters, such as "Alpha Centauri" or "Beta Cygni".
"Flamsteed Numbers" refers to the convention of labelling stars in each constellation with 
numbers, such as "61 Cygni".

The "Label Options" box at the bottom of the dialog box determines which stars are 
labelled.    If "All stars" is selected, then all stars which have the appropriate name will be 
labelled.    If "Brighter than magnitude" is selected, then only those stars brighter than the 
number in the edit box will be labelled.

Notes:

1.    This dialog only determines the way in which stars are labelled.    If order to actually 
display star labels, the "Star Labels" option must be enabled on the "View" menu or the 
ToolBar.

2.    If a star has multiple names, and more than one of the naming options is selected in 
the "Preferences" box, the name highest up the box will be displayed.    Eg, if both the 
"Proper Names" and "Bayer Letters" options are selected, the map would display the name 
"Polaris" in preference to "Alpha Ursae Minoris" when labelling the pole star.



Constellation Names

This option displays a standard font selector allowing the user to select the font used to 
write constellation names on the map.



RNGC Objects
Selecting this option displays the "RNGC Options" dialog box, allowing you to determine 
which deep sky objects are displayed on the map.

The "Object Selection" box determines which catalogue will be searched to find objects to 
display; the entire RNGC catalogue or only Messier objects.

The "Object Types" box controls which objects will be displayed on the map, based on their 
type.    If the "All objects" box is checked, then the other boxes in the group are ignored, 
and all objects which match the other selection criteria will be displayed.    If the "All 
objects" box is not checked, individual types of object can be selected using the other 
boxes in this group.

The "Magnitude Limit" box allows you to control which objects are displayed, based on a 
magnitude selection.    If "All Objects" is selected, then all objects matching the other 
selection parameters will be displayed; if "Brighter than mag" is selected, then only those 
objects brighter than the specified magnitude will be displayed.

Finally, the "Label Objects" box, determines whether displayed objects will be labelled.    If 
the box is checked, objects will be labelled.    Messier objects will be labelled "M" followed 
by a number (eg "M32"); other objects will simply have their RNGC catalogue number 
displayed (eg "1985" refers to the planetary nebula "RNGC 1985" ).

Notes:

1.    This is a complex dialog box - the most complex in the program! - but it gives you the 
ability to exercise very fine control over the non-stellar objects which are displayed.    For 
example, you can make selections such as "only display globular clusters in the Messier 
catalogue brighter than magnitude 11".

2.    The program will only display those Messier objects that are in the RNGC.    Four objects 
in the Messier catalogue are not in the RNGC, so will not be drawn.    These are: M24 (a 
local brightening of the Milky Way), M25 (the open cluster IC 4725), M40 (the wide double 
star Winneke 4), and M45 (the Pleiades).

3.    The RNGC is based on the NGC, compiled towards the end of the 19th century.    As 
such, it contains many incorrect classifications, based on the information available at the 
time.    For example, the Crab Nebula in Taurus, M1, we now know to be a supernova 
remnant, but the RNGC classifies it as a planetary nebula.    The RNGC is, however, a 
catalogue of great historical significance, and no attempt has been made by the author to 
"correct" it.

4.    The symbols used to draw non-stellar objects on the map have been based on those 
used in the authoritative "Uranometria 2000" star atlas.



Colours

This option displays a sub-menu allowing the user to select the colours used for every item 
drawn on the map for either the screen or the printer.    When either "Screen" or "Printer" is 
selected, the "Horizon Map Colours" dialog box is displayed.

To view or edit the colour of any map component, either double click on the name in the 
listbox, or move the listbox highlight to the name and press the "Edit..." button.    Either 
way, a standard colour selector box will be displayed, letting you choose the colour for the 
item.

Notes:

1.    Pressing the "Cancel" button will restore all the colours to their previous settings, not 
only the colour just edited.

2.    The "Printer" colour settings only relate to the printing of colour maps.    Refer to the 
"Printing" topic for further information.



Draw

Selecting this option will draw the map, using the current option settings.    You may press 
the <F5> function key as a "shortcut" for this option.



Using the Sky Area Map

Once the Sky Area map has been drawn, it can be manipulated in various ways.    Most of 
the options are the same as for the Horizon Map, so they are just summarised here for ease
of reference.

Setting the Visibility of Objects
Changing the Map Scale
Identifying Objects on the Map
Zooming to an Area Map
Printing the Map



Setting the Visibility of Objects

The top section of the "View" menu consists of a list of "toggles" controlling the visibility of 
various items on the Area map.    Each item has a corresponding button on the ToolBar.    If 
an item has a tick mark alongside it on the menu, or its button is in a "pressed" state on 
the ToolBar, it is currently visible on the map.    If it does not have a tick mark, or its button 
is not pressed, it is not visible.    The items are:

Stars
Star Labels
Planets
Constellation Figures
Constellation Boundaries
Constellation Names
Right ascension/Declination Grid
RNGC Objects



Changing the Map Scale

The "Zoom In" and "Zoom Out" items on the "View" menu may be used to change the 
magnification of the map.    The <F2> and <F3> function keys are shortcuts for these 
operations, as are the first two buttons on the ToolBar.    When the map is first drawn, it is 
scaled so that the map exactly fills a maximised map window.    Every time "Zoom In" is 
selected, the size of the map increases by 50%, and the map is redrawn.    Every time 
"Zoom Out" is selected, the size is correspondingly reduced.

When the map is zoomed, the centre of the current window will remain stationary.    You can
therefore zoom in a particular feature by first scrolling it to the centre of the window, then 
repeatedly pressing the <F2> key.    To aid this process, a shortcut method has been 
provided to bring a point to the centre:

1.    Position the mouse pointer over the point on the map you would like to bring to the 
centre.

2.    Press the right mouse button.    A pop-up menu will appear at the mouse position.

3.    Select the "Centre" item with the left mouse button.    The window will scroll to bring the
chosen point to the centre of the map.

Note that the map will not scroll past its edges (the boundaries of the full-screen normal 
size map).    In order to bring a point to the centre of the map it may, therefore, be 
necessary to zoom in one or more times first.



Identifying Objects on the Map

To display a dialog box showing information about any object visible on the map, move the 
mouse pointer over the object, and press the right mouse button.    A pop-up menu will 
appear.    Select the item you wish to identify.

Star Identification
Planet Identification
RNGC Object Identification



Zooming to an Area Map

To display a new Area map centred on a particular point on the current map, position the 
mouse pointer over the required point and press the right mouse button.    Select "Area 
Map..." from the pop-up menu.



Printing the Map

To print the map, choose the "Print" option from the "File" menu.    This will display the 
"Print Options" dialog box.

The "View Options" box selects what type of map is drawn.    If "Whole Map" is selected, the
entire map will be drawn, scaled to fit onto the printer page.    If "Current View" is selected, 
the current map view will be printed, at the current zoom factor.

The "Colour Options" box is used to select whether the map is printed in black and white or 
colour.    If "black and white" is selected, all objects on the map are printed black, and the 
map background is left white.    If "Colour" is selected, the map background is again left 
white, but the colour of all other objects is taken from the settings in the 
"Options/Colour/Printer" dialog.    

When the <OK> button is pressed, a standard "Print" dialog is displayed.    This allows you 
to select the printer, resolution, paper orientation etc in the normal way.    Press <OK> from
this dialog to print the map.

Notes:

1.    By default, the map is printed in landscape orientation.    If you wish to change this, use 
the "Print Setup" option.

2.    The default "Print Options" settings of "Whole Map" and "Black and White" correspond 
to the way that maps were printed in previous versions of SkyMap.

3.    The "Current View" printout is intended as a "quick and dirty" method of getting a 
printed map of a zoomed-in area of the sky, without having to draw a separate Sky Area 
map and print that.    No attempt is made to properly scale the map to fit the paper size, 
draw borders, or anything else.    If you have a very high zoom factor set, and try to print to 
a high-resolution device using this settings, problems may occur.

4.    The "Colour" setting in the "Colour Options" box can be used to print a grey-scale map 
even on a black and white printer.    The exact correspondence between colours and shades
of grey will depend on the capabilities of the printer driver.    This works beautifully on a 
PostScript laser printer; not so well on an Epson 9-pin dot matrix printer!



Displaying Pictures

One of the most exciting features of SkyMap is its ability to display photographic images of 
astronomical objects.    You can build up your own collection of pictures which, together with
the maps, can really bring the sky to "life", and which are a superb way to show 
astronomical objects to a novice on a cloudy night! (Here in England we get a lot of cloudy 
nights!)

In order to display pictures, you really need a "SuperVGA" display capable of displaying 256
or more colours at once.    You can display pictures on a standard 16-colour VGA display, but
the results will probably be pretty horrible!

Picture Formats
Displaying Pictures Manually
Displaying Pictures Automatically
Obtaining Picture Files



Picture Formats

SkyMap can currently display picture files in the following formats:

1.    GIF files.    GIF is probably the most popular of all image formats currently in use.    The 
format was specifically devised to enable pictures to be easily transferred between different
types of computer, and there are literally tens of thousands on pictures in GIF format 
available.    SkyMap will display files in either GIF87a or GIF89a format, and can handle both
interlaced and non-interlaced images.    The only restriction is that only the first image in a 
file can currently be displayed.    GIF files for the PC normally have an extension of ".GIF".

2.    Windows "Bitmap" files.    These are "device independent bitmap" files created for use 
with Microsoft Windows.    They normally have an extension of ".BMP" (for uncompressed 
images) or ".RLE" (for compressed images).    An increasing number of these files can be 
found on bulletin board systems, normally made available for use as Windows "wallpaper".



Displaying Pictures Manually

From the "File" menu, choose the "Open Image..." item.    A standard file selector will be 
displayed, letting you select a file from any available drive or directory.    Pressing the <OK>
button will create a new window in which the image will be displayed.



Displaying Pictures Automatically

SkyMap has the ability to load and display pictures of certain object automatically.    This 
can be done for all RNGC objects, as well as the planets, Moon, and Sun.    In order to use 
this feature of the program, carry out the following steps:

1.    Find a nice picture of an RNGC object or planet in any supported image format.    You 
can use the "manual" method described above to look through pictures until you find one 
you would like to have as a "standard" picture for a particular object.

2.    Copy the picture to the directory containing the SkyMap program, and rename the file 
to "OBJECT.EXT", where "OBJECT" is the name of the object, and ".EXT" is the "standard" 
extension for the image format - ".GIF" for GIF files and ".BMP" for bitmap files.

For planets, the name used should be one of the following:

SUN
MOON
MERCURY
VENUS
MARS
JUPITER
SATURN
URANUS
NEPTUNE

For Messier objects, the name should be "M" followed by the Messier number; "M32", for 
example.

For other RNGC objects, the name should be "NGC" followed by the RNGC catalogue 
number; "NGC1530A", for example.

3.    Now, if you draw a map and click the right mouse button over an object for which a 
picture has been stored, you should find that a "Picture of <object>" item appears on the 
resulting pop-up menu.    Selecting this item will display the picture in a new window.

Notes:

1.    When you click on a object, SkyMap will first of all look for a file with a ".GIF" 
extension, and then for a file with a ".BMP" extension.    If files with both extensions are 
present, the GIF file will be displayed.



Obtaining Picture Files

There are many sources from which picture files (particularly GIF images) suitable for use 
with SkyMap can be obtained.    Some of these are:

1.    Commercial information services such as CompuServe or BIX.    An especially good 
source is the CompuServe "Astronomy" forum (type "GO ASTROFORUM" from any prompt), 
which currently has more than 1000 astronomy and space-related GIF files available.

2.    Bulletin board systems, of which there are a vast and ever-changing number.    Some of 
these specialise in astronomy and carry a large number of GIF images.

3.    Public domain and shareware software libraries.

4.    If you have access to it, perhaps the best source of all are the vast resources of the 
Internet - a world-wide computer network.    Take a look, for example at the machine 
"ames.arc.nasa.gov", in directory "pub/SPACE/GIFS".

5.    Finally, if you get really stuck, I can supply you with GIF images for the cost of the disks 
plus a small handling fee.    Refer to the separate registration form for details.



Data Sources and Precision

The sources of the data used by SkyMap are as follows:

Stars
Planets and Sun
Moon
RNGC Objects
Time Corrections



Stars

Smithsonian Astrophysical Observatory (SAO) star catalog,    (SAO Staff, 1966), 1990 
machine readable version, as supplied on NASA's National Space Science Data Center's 
"Selected Astronomical Catalogs, Volume 1" CD-ROM.

The SAO star catalog is a catalog of 258,997 stars to epoch J2000.0, and is reasonably 
complete down to magnitude 9.5 or so.    The star database supplied with the shareware 
version of SkyMap contains all the stars from the SAO catalog down to magnitude 7.0 - a 
total of 15,931 stars.    Larger databases, up to and including the full SAO catalog,    can be 
supplied to registered users of SkyMap for a small    fee - refer to the separate registration 
form for details.

SkyMap rigorously reduces star positions from mean to apparent place.    The following 
corrections are applied:

Precession
Proper Motion
Nutation
Aberration

In the case of the Horizon Map, the apparent place is used to compute the local altitude 
and azimuth of the star, and the altitude is then corrected for the effects of refraction.



Planets and Sun

The positions of the Sun, and the planets Mercury to Neptune are computed using a subset 
of    Bretagnon and Francou's VSOP87 planetary theory, as described in the book 
"Astronomical Algorithms", by Jean Meeus (Willman-Bell, 1991).

Spot checks against recent editions of the "Astronomical Almanac" indicate that the mean 
error in the computed positions of the planets is under half a second of arc, with peak 
errors of about one arc second.    For comparison, the apparent diameter of the planet 
Neptune is about 2", whilst that of Jupiter is typically 35".



Moon

The position of the moon is computed from the ELP 2000-85 lunar theory (Chapront-Touzé 
and Chapront, 1988), which in turn is fitted to the DE200/LE200 numerical integration of 
the Jet Propulsion Laboratory (Standish, 1981).

Spot checks against the "Astronomical Almanac" again indicate that the mean error in the 
computed position of the Moon is about half an arc second, with peak errors around one arc
second.



RNGC Objects

For non-stellar objects, SkyMap uses the machine-readable version of the "Revised New 
General Catalog of Non-stellar Astronomical Objects" (Sulentic and Tifft, 1973), or RNGC.    
This is a modern, revised and expanded version of the "New General Catalogue of Nebulae 
and Clusters of Stars" (Dreyer 1888).



Time Corrections

Because of the irregularities in the Earth's rotation, the theories of motion of astronomical 
bodies do not use Universal Time (GMT), but a uniform timescale called Terrestrial 
Dynamical Time (TDT).    SkyMap uses TDT internally for all its calculation of planetary 
positions, etc, but obviously the user specifies the time for which a map is required in UT 
(or rather, in local time, which is converted to UT).

The difference between TDT and UT is called "delta T", and currently has a value of 
approximately 1 minute.    It is currently increasing at a rate of somewhat less than 1 
second per year.    The problem is that the value of delta T can only be determined 
historically (typically by analyzing the motion of the Moon), and current and future values 
can only be estimated, whilst values for the distant past (before the advent of modern 
astronomy) are uncertain to the order of many minutes.

What this means in practice is that although the time of a total solar eclipse in the year 
1500BC could be computed to a precision of a fraction of a second in TDT, the actual time 
in UT that the eclipse occurs (hence the places on Earth from which it is visible) will be 
uncertain to within several minutes.

The "Astronomical Almanac" lists the values of delta T for every year from 1620 onwards 
(currently up to 1992), and provides estimates of its value for the current time.    SkyMap 
has all this data stored, and interpolates or extrapolates in this table to find values of delta 
T for dates between 1620 and 2000.

For dates beyond the year 2000, an estimate of delta T is made using the method of 
L V Morrison and F R Stephenson, "Sun and Planetary System" vol 96,73 eds. W Fricke, 
G Teleki, Reidel, Dordrecht (1982).

For dates prior to 1620, an estimate is made using the method of    F R Stephenson and 
M A Houlden, "Atlas of Historical Eclipse Maps", Cambridge University Press (1986).    They 
estimate the uncertainty to be 15 minutes at 1500BC.



Dreyer Descriptions

The RNGC catalogue of non-stellar objects includes the visual descriptions used by Johann 
Dreyer in his "New General Catalogue", published in 1888.    These descriptions are 
remarkable for their information content, but can be somewhat daunting at first.    For 
example, the Dreyer description of the globular cluster M3 in Canes Venatici is as follows:

GCL,EB,VL,VSMBM,*11

This can be translated as "Globular cluster, extremely bright, very large, very suddenly 
much brighter towards the middle, composed of 11th magnitude stars" - a pretty good 
description in only 19 characters!

Similarly the galaxy NGC 2863 in Hydra is described as:

CF,S,E,BET2*12,16

which means "considerably faint, small, elongated, between two stars of magnitude 12 and
16".

The description normally starts with a description of the object's brightness and size.    
Dreyer adopted the scale used for this from Sir John Herschel, and the order used may be 
confusing to modern observers; for example, is "considerably faint" brighter or fainter than 
merely "faint"?    The other possible source of confusion is that 19th century astronomers 
often called a faint star "small" and a bright star "large", so one always has to be careful to 
judge whether a description such as "pretty small" refers to size or brightness!

The scale used is as follows:

Brightness Size

EF Excessively faint ES Excessively small
VF Very faint VS Very small
F Faint S Small
CF Considerably faint CS Considerably small
PF Pretty faint PS Pretty small
PB Pretty bright PL Pretty large
CB Considerably bright CL Considerably large
B Bright L Large
VB Very bright VL Very large
EB Extremely bright EL  Excessively large

Next normally comes a description of object's general shape.    This lies on a scale ranging 
from "round" to "extremely extended", as follows:

Code Shape



R Round
VLE Very little extended
E Elliptic or oval
CE Considerably extended
PME Pretty much extended
ME Much extended
VME Very much extended
EE Extremely extended

By far the most cryptic part of the description, at first glance, is the group of letters giving 
what Sir John Herschel described as "the degree and rate of condensation".    A simple 
example is "GBM", meaning "gradually brighter towards the middle".    Looking, though, at 
NGC 4725, a galaxy in Coma Berenices, we find the dreadful looking "VSVMBMEBN"!    Even 
this mouthful, though, is fairly easily translated as "very suddenly very much brighter in the
middle, with an extremely bright nucleus".

When the descriptions give directions on the sky, the terms "preceding" and "following" are
used for west and easy respectively.    To see what is meant by this, picture the way an 
object drifts across the field of view of a telescope if the drive is switched off.    Use of these
terms is much more natural at the telescope eyepiece than the very confusing west and 
east, given the way that optical systems invert and/or reflect the field of view.

Quite often the notes speak of groups.    The "1st of 4" is the first member of a group of four
nebulae to drift across the field of view ie, the most western one, preceding all the others.    
All members of a group will have very nearly the same declination.

The complete list of abbreviations used in the Dreyer description of an object appears 
below:

Code Meaning

AB about
ALM almost
AM among
APP appended
ATT attached

B bright
B brighter (always coupled with another letter)
BET between
BF brighter toward following side
BIN binuclear
BN bright toward north side
BP brighter toward preceding side
BS brighter toward south side

C compressed
C considerably
CH chevelure
CL cluster
CO coarse, coarsely



COM cometic
CONT in contact
D double
D diameter
DEF defined
DIF diffused
DIFFIC difficult
DIST distance

E extended
E extremely, excessively
EE most extremely
ER easily resolvable
EXC excentric

F faint
F following

G gradually
GCL globular cluster of stars
GR group

I irregular
IF irregular figure
INV involved, involving

L large
L little (adv.), long (adj.)

M middle or in the middle
M much
MM mixed magnitudes
MN milky nebulosity

N nucleus or to a nucleus
N north
NEB nebula
NF north following
NP north preceding
NR near

P poor
P preceding
P pretty (before F, B, L, S) (size and brightness blocks)
PG pretty gradually
PLN planetary nebula
PM pretty much
PS pretty suddenly

QUAD quadrilateral
QUAR quartile

R round
R resolvable
RI rich



RR exactly round
RR partially resolved, some stars seen
RRR well, resolved, clearly consisting of stars

S small
S suddenly
S south
SC scattered
SEV several
SF south following
SH shaped
SM smaller
SP south preceding
ST stars
ST9 stars from the 9th magnitude downward
ST9...13 stars from 9th to 13th magnitude
STELLstellar
SUSP suspected

TRAP trapezium
TRI triangle, forms a triangle with
TRIN trinuclear

V very
VAR variable
VV very very,    an intensive of V

* a star (or stars)
*10 a star of 10th magnitude
** double star
*** triple star
() items questioned by Dreyer enclosed in parentheses
" arc seconds (two "not-equals" in published catalogue)
' arc minutes (one "not-equals" in published catalogue)




